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1. Введение

Система проектирования печатных плат P-CAD начала использоваться в промышленности более 10 лет назад, когда только появились компьютеры на 286 процессорах и на них осваивали систему P-CAD 2.0. Следующими версиями были 3.0, 4.5, 8.5 - 8.7. Версия P-CAD 8.7, о которой будет идти речь в данной работе, появилась в марте 1998 года.    

1.1. Основные особенности версии 8.7

· существенно изменён интерфейс (от версии 4.5) 
· 32-х разрядная база данных (в версии 4.5 - 16-ти разрядная);
· обеспеченна возможность удаления неиспользуемых слоёв в базах данных принципиальных схем и печатных плат;
· введены атрибуты цепей для передачи в программу контроля DRС и программу автотрассировки SPECCTRA технологических ограничений (ширина проводников, зазоры и типы переходных отверстий);
· обеспеченна возможность назначения толщины не только линий, но и букв при печати чертежей с помощью утилиты WinPlot (вывод на периферийные устройства осуществляется средствами Windows);
· введены "горячие" клавиши "+", "-"  для изменения масштаба изображения и Ctrl+R, Alt+R для вращения объектов при выполнении команд Enter>Component, Move>Component;
· усовершенствован механизм выбора перекрывающихся объектов в соответствии с их приоритетом;
· введена задержка включения отображения электрических связей на печатных платах после завершения перемещения компонентов;
· производиться центрирование текста при простановке размерностей;
· возможен просмотр каталогов при выборе файлов по команде File>Load, Environment>Attach Padstacks, Environment>Edit Aperture Table>Load AT (ранее файлы выбирались только в пределах текущего каталога);
· предусмотрена возможность редактирования стеков контактных площадок, не выгружая печатную плату (по команде File>Push Padstack);
· введён системный каталог для размещения стандартных файлов специальных символов (.ssf), таблиц апертур (.apr), стеков контактных площадок (.ps) и др.;
· реализована автоматическая простановка позиционных обозначений и номеров секций компонентов при вводе их символов на схему;
· привязка к не находящемся в стеке объектам при выполнении измерений;
· захват ближайшего вывода компонента при его редактировании и опросе (ранее курсором нужно было попасть точно в центр вывода);
· в значениях атрибутов PWGD разрешено использовать символ точки ".";
· в отчётах упорядочена сортировка цепей по именам.
1.2. Основной недостаток   

Невозможность непосредственного нанесения на чертежи схем и плат надписей, содержащих символы кириллицы.

1.3. Минимальные требования к системе

Система P-CAD 8.7 может быть установлена на ПК, совместимый с IBM PC, на базе процессора 80486 и старше. Минимальные требования приведены в таблице 1.1.

Таблица 1.1. 
Минимальные требования к системе
	Объём оперативной памяти 
	4 Мбайт – работа со схемами

8 Мбайт – работа с ПП

12 Мбайт – автотрассировка

	Манипулятор мышь
	Обязателен (желателен 3-х кнопочный)

	Свободное пространство на жёстком диске 
	Не менее 60 Мбайт

	Тип монитора 
	Не хуже VGA


1.4. Функциональные возможности и структура 

Фирма ACCEL Technologies выпускает два варианта системы P-CAD: Master Designer и  Associate Designer. Оба варианта обеспечивают проектирование многослойных ПП, но различаются своими возможностями. Большими возможностями обладает вариант Master Designer, о котором и пойдёт речь. 

Система поддерживает широкий набор цветных графических дисплеев, принтеров и фотоплоттеров, манипуляторов и цифровых планшетов различных типов. Система настраивается на конкретный состав оборудования с помощью набора драйверов и позволяет выполнять следующие проектные операции:

· создание символов элементов принципиальной электрической схемы и их физических образов - корпусов;

· графический ввод принципиальной электрической схемы и конструктивов плат проектируемого устройства;

·  одно- и двустороннее размещение разногабаритных элементов с планарными и штыревыми выводами на поле ПП с печатными и навесными шинами питания в интерактивном и автоматическом режимах;

· ручную и автоматическую трассировку печатных проводников произвольной ширины в интерактивном режиме (число слоёв 1…32);

· автоматизированный контроль результатов проектирования ПП на соответствие принципиальной электрической схеме и конструкторско-технологическим ограничениям;

· автоматическую коррекцию принципиальной электрической схемы по результатам размещения элементов на ПП (после эквивалентной перестановки выводов и/или вентилей компонентов);

· полуавтоматическую корректировку разработанной ПП по изменениям, дополнительно внесённым в принципиальную электрическую схему;

· выпуск чертежей принципиальных электрических схем, управляющих файлов для изготовления фотошаблонов и сверления отверстий с помощью станков с ЧПУ и текстовой документации на проектируемую ПП.

В таблице 1.2. приведены ограничения, накладываемые на объект проектирования.

  Таблица 1.2. 
Ограничения, накладываемые на объект проектирования

	Максимальное количество компонентов в проекте
	32000

	Максимальное количество цепей в проекте 
	64000

	Максимально допустимое число выводов в проекте
	250000

	Максимальное количество выводов на один компонент
	5000

	Максимальное количество вентилей в компоненте
	5000

	Максимальное количество типов вентилей в компоненте
	9

	Расположение ЭРИ на плате 
	Двустороннее

	Максимальный размер платы, если разработка ведётся:

· английской системе

· метрической системе
	20 000х20 000"

200х200 м

	Число типов контактных площадок и переходных отверстий 
	Не более 255

	Число символов в имени ЭРИ
	Не более 8

	Максимальное число слоёв трассировки 
	32

	Максимальное число вершин полигонов
	10 000

	Точность задания координат и размеров на плате:

· английской системе

· метрической системе
	0,01 мил =0,00001"

0,1 мкм=0,0001 мм


Итак, с помощью системы P-CAD решаются следующие задачи.

1. На этапе функционального проектирования:

· Создание библиотеки графических изображений символов компонентов;

· Формирование принципиальной электрической схемы;

· Анализ ошибок в принципиальной электрической схеме;

· Выпуск принципиальной электрической схемы.

2. На этапе конструкторского проектирования: 

· Создание библиотеки конструктивов корпусов компонентов; упаковка вентилей по корпусам, построение базы данных печатной платы;
· Интерактивное и/или автоматическое размещение компонентов на плате;
· Интерактивная и/или автоматическая трассировка электрических соединений;
· Выпуск эскиза размещения компонентов на плате (контур платы с упрощенным изображением компонентов) и эскизов трассировки слоёв;
· Подготовка данных для получения фотошаблонов на фотоплоттере.
2. Общая структура РСАD - 4.5.

 2.1. Группа модулей: ввод Ф3, размещение, трассировка, КД и связи между ними. 4 режима работы.

PCAD представляет собой интегрированный пакет, состоящий из 4-х групп модулей и обеспечивает 4 режима функционирования (рис. 2.1).

Первая группа модулей обеспечивает ввод формализованного задания (ФЗ), вторая группа - размещение элементов, третья - трассировку соединений, а четвертая группа - БД и выпуск конструкторской документации (КД).

Система обеспечивает следующие режимы функционирования:

режим 0 - система механизированного изготовления фотошаблона (МИФ).

В этом режиме конструктор обеспечивает интерактивное рисование всей топологии печатной платы (включая все трассы). В PCAD функционирует единственный модуль (интерактивный ввод конструкторско-технологической информации), а также используется модуль выпуска КД.
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режим 1 - интеллектуальная система МИФ.

В отличие от режима 0 трассировка выполняется автоматически, а конструктор вручную указывает какой контакт с каким соединять.

режим 2 -  интерактивная САПР ДПП (полный режим PCAD)

Работают все модули.  

режим 3 - старый (альтернативный) вариант САПР ДПП.

Отличается от режима 2 тем, что электрическая схема описывается в текстовом виде, т.е перечисляются имена элементов и контактов для соединения.  
2.2. Структурная схема РСАD - 8.7. Модули PCCAPS, PCCARDS,  PCROUTE  и связи между ними. Работа с библиотеками и файл *.fil.

Структурная схема PCAD 8.7  показана на рис. 2.2.
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Рис. 2.2. Структурная схема системы 

PCAD 8.7.


Процесс проектирования ПП состоит из нескольких этапов. На каждом из них используется отдельные программы системы РCAD, взаимосвязь которых иллюстрируется на рис 2. Перейдем к краткому описанию основных этапов проектирования ПП.

Этап 0. Перед началом разработки ПП должны быть созданы библиотеки символов компонентов РЭК для создания принципиальных электрических схем (в файлах с расширением .SYM) с помощью программы Symbol Editor (PCCAPS), библиотеки их конструктивов (в файлах .PRT) и стеков (этажерок) контактных площадок (в файлах .ps) в помощью программы Part Editor. Файлы отдельных компонентов целесообразно объединить в библиотечные файлы .SLB и .PLB с помощью программы Library Maintenance.

Этап 1. Создание базы данных принципиальной электрической схемы с помощью Schematic Editor (PCCAPS) (в файле с расширением .sch, блок 1 на рис. 2.1.) и проверка схемы с помощью Electrical Rules Check (PCERC).

Этап 2. Схемотехническое моделирование с помощью программы DesignLab, ViewLogic и др.

Этап 3. Создание файла базы данных ПП в автоматическом режиме (имеющего расширение .PCB или . PKG) двумя способами:

1. на основе информации, содержащейся в файлах списков соединений, составленных по принципиальной электрической схеме (.NLT или .XLT), и файле перекрестных ссылок .FIL, а также файла конструктива ПП .PCB (блок 2);

2. на основе текстового файла с расширением .ALT, в котором пользователь описывает состав проектируемой ПП (при этом чертеж принципиальной схемы не создается, блок 5). Такой способ применяется крайне редко.

Этап 4. Размещение компонентов на ПП вручную, автоматически или интерактивно с помощью графического редактора PCB Editor (PCCARDS) (блок 4). В последних двух случаях можно (но не обязательно) предварительно вручную расставить компоненты на ПП и трассировать шины питания и «земли».

Этап 5. Трассировка соединений с помощью программы Autorouter (PC-ROUTE)       (блок 6) вручную с помощью программы PCB Editor (PCCARDS) (блок 4).

Этап 6. Работа со вспомогательными программами (утилитами) для верификации ПП, сопоставления чертежей принципиальных электрических схем и ПП и внесения в них изменений, выпуска текстовых отчетов (блок 7,10).

Этап 7. Выпуск конструкторско-технологической документации средствами DOS (Hardcopy) (блок 8) или Windows  (WinPlot) (блок 11).

Замечание.

В конструкторском модуле в обязательном порядке обрабатывается информация о контактах, посадочных местах элементов, корпусах элементов, конструктиве печатной платы, а также размещение и связи. Все первичное кодирование, размещение и трассировка, по умолчанию, выполняется в условных контактных площадках одного размера и типа. Для задания же реальных контактных площадок используется специальный механизм кодирования (файлы  .PS и  .SSF). 

2.3.  Технология работы модулей РСАD для 4-х режимов работы. Характеристики системы.
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Рис. 2.3. Режимы работы модулей 
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2.4. Основные сведения о логических слоях для схемотехнического проектирования.

В PCAD используется послойный подход к проектированию, т.е. информация может быть разнесена на различных, совмещенных друг с другом “прозрачных” слоях. 

	№
	Слой
	Назначение слоя
	Активизация

	1
	GATE
	рисуночный слой и слой для размещения элементов
	ENTR / COMP

	2
	DEVICE
	текстовые надписи, имена компонентов (элементов)
	DRAW / TEXT

	3
	PINCON
	контакты (соединения контактов)
	ENTR / PIN

	4
	PINNAM
	имена контактов
	ENTR / PIN

	5
	PINNUM
	номера контактов
	SCMD / PNUM

	6
	REFDES
	имена компонент (секций), т.е. вентилей в элементе 
	SCMD / PNUM

	7
	---
	характеристики контактов (тип, эквивалентность)
	---

	8
	ATTR
	Атрибуты
	ATTR / ...

	9
	WIRES
	цепи (проводники)
	ENTR / WIRES

	10
	BUS
	Шины
	ENTR / WIRES

	11
	NETNUM
	имена цепей
	NAME / NET

	12
	CPMNUM
	имена компонент
	NAME / COMP

	13
	NOTES
	текстовые надписи
	ATTR / ...

	14
	SDOT
	точки “пайки”
	ATTR / ...

	15
	BORDER
	рамка черт. поле трассировки
	



[image: image4.wmf]Рис. 2.4. Основные логические слои PC-CAPS.
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2.5. Основные сведения о логических слоях для конструкторского проектирования.

1) PIN - контактные площадки

2) SCKSCR - слой для сборочного чертежа (корпуса ЭРЭ для СБ, контур платы)

3) DEVICE - имя компоненты

4) упаковка - специального слоя нет, погружена в другие слои

5) ATTR - слой атрибутов 

6) BRDOUT - зона для трассировки

7) COMP - слой компонентов

8) SOLDER - слой связей

В PCAD вводится понятие контактных площадок для КД (конструкторской документации) и для ФШ (фотошаблона).

9) PADCOM - слой компонентов для КД

     PADSLD - слой связей для КД

10) FLCOMP - слой компонентов для ФШ

      FLSOLD - слой связей для ФШ


[image: image5.wmf]Рис. 2.5. Основные логические слои PC-CARDS.

DIP14

PIN-

конт. площадки

SLKSCR - 

корп. ЭРЭ, контур платы

DEVICE - 

имя компоненты

ATTR - 

атрибуты

BRDOUT - 

контур для трассировки

COMP - 

слой компонент (1-й слой ДПП, здесь разм. ЭРЭ

SOLDER - 

слой связей (2-й слой ДПП)

PADCOM - 

графика К.П. со стороны слоя COMP

FLCOMP - 

ссылка 

на №:

PADSLD - 

графика КП со стороны слоя SOLDER

FLSOLD - 

ссылка 

на №:

DRILL - 

центры К.П. для сверления

1.

2.

7

4

0

0


2.6. Функциональные схема и связи между модулями PCCAPS, Package Schematic (PCNODES, PCLINK, PCPACK), *.SYM, *.FIL, PCCOMP, *.PRT, PCCARDS, *.PS, *.SSF.

Функциональная схема и связи между модулями показаны на рис. 2.6.

Ввод электрической схемы обеспечивается модулем PCCAPS с точностью 0.1мм или 0.01”(1”- 2.54мм). Возможно два режима ввода: SYMB и DETL. Модуль PCCARDS обеспечивает ввод конструкции печатной платы с точностью 0.01мм или 0.001”.

В символьном режиме (SYMB) вводится следующая информация: контактные площадки и их расположение, корпуса элементов и реальные маски контактных площадок для конструкторской документации и для изготовления фотошаблона.


[image: image6.wmf]Рис. 2.6. Функциональные схема и связи.

PCCAPS

PACKAGE

SCHEMATIC

реж. SYM

&

Граф

. 

ввод:

а) симв.

б) СхЭ

&

&

. SYM

реж. DETL

. SCH

Библ. ЭРЭ

PCCOMP

Библ

. 

конст.

PCCARDS

Техн. библ. ЭРЭ

Сх. библ. ЭРЭ

PCLIB

. PLB

. SLB

¥

Текст

.

ред.

WinPlot

Hardcopy

Библ

. 

масок

Ґ

Текст

. 

ред.

0.01”

0.1 

мм

. PLT

. SCH

. PRT

. PCB

. PLC

. SSF

а) конт. пл.

б) корп.

ЭРЭ

г) маски ФП

в) формы

к.п.

реж. SYM

а) трассир.

б) посад

. 

места

в) связи

реж. DETL

0.001”

0.01 

мм

к моделяторам:

DesignLab

,

ViewLogic

к  PC-ROUTE

к  PC-ROUTE

(

по “запросу”)

Ґ

Синхронизация двух БД

. FIL


В детальном режиме (DETL) вводится информация о контуре печатной платы, о контуре зоны для трассировки, зоны для запрета размещения и зоны для запрета трассировки. Может вводится информация о расположении отдельных контактных площадок на печатной плате, а также указатели о связях между ними.

Для синхронизации конструкторских элементов и символьных библиотек готовится файл .FIL. Для простых однозначных элементов файл .FIL может отсутствовать. 

Информация о формах контактных площадок готовится в файле .PS, а привязка этого файла, т.е. синхронизация его с трассировкой осуществляется в файле .SSF (готовится в текстовом редакторе).

2.7. Функциональные схема и связи между модулями Package Schematic (PCNODES, PCLINK, PCPACK),  PCCARDS,PCROUTE, *.ctl, *.alt, PCNLT, *.pkg..

Функциональная схема и связи между модулями показаны на рис. 2.7.

Вся выходная информация подается на модуль Package Schematic который всю информацию об элементах и печатной плате приводит к образу печатной платы.

2.8. Управление  стратегией  размещения  и  стратегией  трассировки (*.ctl).  Основные  режимы  из  стратегий.  Выходы  PCAD  и  использование  реальных  масок.  ФШ  и  КД.

Модуль “размещение” обеспечивает различные режимы в зависимости от равнозначной стратегии. 

Основные стратегии: 

1. Полное автоматическое размещение.

2. Частичное либо полное ручное размещение элементов.

3. Возможность размещения элементов в различных условных сетках и для каждой сетки задается свой шаг размещения.

4. Возможность задания запретов для размещения.

5. Возможность задания зазоров для родственно-связанных элементов.

    Модуль трассировки работает считывая  специальный файл стратегии трассировки (*.ctl): 

— выбор одного из вариантов трассировки;

— порядок прокладки трасс;

— разрешена ли трассировка под углом 45(;

— минимальное число переходных отверстий;

— минимальное число перегибов трасс;

— назначение числа итераций проходов трассировщика;

— назначение числа итераций уплотнения трасс;

— реальные контактные площадки;

— зазор/ширина трасс

— ориентация элементов.


[image: image7.wmf]Рис. 2.7. Функциональная схема и связи.
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2.9. Управляющая оболочка системы РCAD. Экран и меню PC-CAPS. Строка сообщений, статус-строка. Координатная единица DBU и дискреты проектирования схемы и конструкции. Ограничения. Этапы работы. 

Запуск системы PCAD производится либо из под Windows, либо  из каталога РCAD с помощью командного файла pcad.bat вида :

           @ echo off

           pcad_exe

Также любую программу можно вызвать автономно с помощью командной строки DOS.


После вызова системы РСАD на экран выводится ее основное меню
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Рис. 2.8. Основное окно PCAD 8.7.

Список имен проектов (Design), принципиальный схем (Schematic Sheet) и печатн

ых плат (PCB Layout) размещаются в трех окнах в нижней части экрана. В верхней части экрана указаны заголовки 5 разделов:

· Design Manager – администратор сети;

· Schematic Tools – создание электрических принципиальных схем;

· PCB Tools – разработка плат печатного монтажа;

· Library Manager – администратор библиотек;

· Interface – интерфейсы с другими программами и периферийным оборудованием.


[image: image8.wmf]
В нижней части экрана расположены три панели.

· Report Editor – редактирование текстовых файлов с помощью внешнего редактора.

· DOS Shell – выход в DOS для вызова любой программы, для которой достаточно памяти.

· QUIT – завершение работы с PCAD.

Для выбора раздела нужно щелкнуть мышью на его заголовке, и в средней части экрана выводится список режимов выбранного раздела.

Приведем перечень режимов всех разделов.

1. Раздел Design Manager имеет режимы:

· Design Maintenance – сопровождение проектов;

· System Configuration – установка конфигурации системы;

· Report Generator – составление текстовых отчетов о текущей схеме или о всех схемах текущего проекта с помощью PC-FORM.

· Engineering Change Order – внесение изменений в проект с помощью программы PC-ECO.

· Netlist Comparison – сравнение списков электрический связей с помощью программы PC-NLC.

2. Раздел Schematic Tools имеет режимы:

· Editor Configuration – установка конфигурации графического редактора принципиальных схем и символьных компонентов (программы PC-CAPS);

· Schematic Editor – вызов графического редактора принципиальных схем (доступны оба режима Detail Mode и Symbol Mode);

· Electrical Rules Check -  вызов программы проверки принципиальных схем PC-ERC;

· EZPlot – создание .plt файла без загрузки файла базы данных в графичекий редактор(с помощью программы PC-EZPlot);

· Package Schematic -  создание файла упакованной базы данных ПП с помощью программы PC-PACK;

· Report Generator – составление текстовых отчетов о текущей схеме или о всех схемах текущего проекта с помощью PC-FORM;

· Hardcopy – вывод твердых копий на принтер и плоттер с помощью программ PC-LPS, PC-PRINT и PC-PLOTS;

· Delete Unused Layer – удаление неиспользуемых слоев базы данных схемы;

· PDIF File Reader – создание файла базы данных схемы по текстовому файлу в формате PDIF с помощью программы PDIF-IN;

· PDIF File Writer – создание текстового файла в формате PDIF с помощью программы PDIF-OUT;

· Netlist – составление файлов списка соединений базы данных с расширениям  .nde и .net с помощью программ PC-NODESPC-LINK NETLIST.

3. Раздел  PCB Tools имеет режимы:

· Editor Configuration – установка конфигурации графического редактора принципиальных схем и символьных компонентов (программы PC-CAPS);

· PCB Editor – вызов графического редактора печатных плат (PC​-CARDS);

· Autorouter – вызов программы автоматической трассировки PC-ROUTE;

· Design Rules Check – проверка ПП с помощью программы PC-DRC;

· EZPlot – создание .plt файла без загрузки файла базы данных в графичекий редактор(с помощью программы PC-EZPlot);

· PDIF File Reader – создание файла базы данных схемы по текстовому файлу в формате PDIF с помощью программы PDIF-IN;

· PDIF File Writer – создание текстового файла в формате PDIF с помощью программы PDIF-OUT;

· Hardcopy – вывод твердых копий на принтер и плоттер с помощью программ PC-LPS, PC-PRINT и PC-PLOTS;

· Report Generator – составление текстовых отчетов о текущей схеме или о всех схемах текущего проекта с помощью PC-FORM;

· Delete Unused Layer – удаление неиспользуемых слоев базы данных схемы;

· Drill – вывод информации для сверления отверстий в ПП с помощью программы PC-DRILL;

· Auto-Insertion – вызов программы PC-INSERT, создающей управляющие файлы для оборудования автоматического монтажа ПП;

· Netlist Conversion – создание упакованного файла базы данных ПП по ее текстовому описанию с помощью программы PC-NLT;

· Aperture Table Editor – редактирование таблиц апертур фотоплоттеров;

· Shapetech Router – интерфейс с программой SPECCTRA.

4. Раздел Library Manager имеет режимы:

· Set Libs & Set Paths – задание имен библиотечных файлов, маршрутов поиска библиотечных файлов и файлов отдельных символов и корпусов компонентов;

· Library Maintenance – вызов программы работы с библиотеками PC-LIB;

· Symbol Editor – вызов графического редактора принципиальных схем (программа PC-CAPS режим Symbol Mode)

· Part Editor – вызов графического редактора корпусов компонентов (программы PC-CADS режим Symbol Mode);

· Component Editor – просмотр и редактирование текстовой информации  о символах и корпусах компонентов с помощью программы PC-COMP;

· Assign RefDes PreFix – присвоение префиксов позиционных обозначений компонентов.

5. Раздел Interface имеет режимы:

· Add Program – добавление в меню данного раздела произвольных программ по желанию пользователя;

· SPICE Circuit Write – создание текстового файла формата PDIF, созданного программой Pspice;

· Viewlogic Interface – преобразование файлов формата в формат PCB-файлов;

· DXF File Write -  преобразование SCH- и PCB-файлов в формат DXF программы AutoCAD;

· DXF File Reader -  преобразование файлов программы AutoCAD формата DXF в SCH- и PCB-файлы;

· EDIF Netlist Reader – создание файла база данных проекта по текстовому описанию в формате EDIF;

· EDIF Netlist Writer – создание файла в формате EDIF для текущего проекта.

Содержимое экрана программы PCCAPS выглядит следующим образом.
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Рис. 2.9. Экранное меню PCAD 8.7.

 Структура статусной  строки зависит от того какие команда в данный момент активизированны.

	Поле статусной строки и команды управления экраном.
	Назначение
	Режим
	Активизируется командой.

	Angle
	Установка для вводимого компонента (град)
	DETL
	Enter/Component

	Size:
	Установка высоты текста (от 2 до 500 DBU)
	SYMB, DETL
	Enter/Attribute, Pin;

Draw/Text;

Query/Object;

Name/Net, Component;

	Wid:
	Установка ширины линии (от 2 до 255 DBU)
	 Тоже
	Draw/Line, Cycle, 2-Point Arc, 2-Point Arc, Rectangle;

Enter/Wire

	Grd:
	Установка шага координатной сетки (от 0,01 до 2000 DBU)
	Тоже
	Любая команда

	XY:
	Указание текущих координат, позиционирование курсора
	Тоже
	Любая команда

	ByName
	Выбор (компонента, цепи) по запросу его имени
	Тоже
	Move/Group, Critical Path, Component; Enter/Replace Component; Query/Component, Net, Group;

	Unnamed
	Имя компонента или цепи
	DETL
	Enter/Wire, Component;

	(Bottom/Top/Center
	Привязка текста по вертикали (нижняя, верхняя, центральная)
	SYMB,

DETL
	Enter/Attribute, Pin;

Draw/Text;

Name/Net, Component;

	(Dashed/Dotted/Solid
	Характер линии (штриховая, пунктирная, сплошная)
	Тоже
	Enter/Wire; Draw/Line, Cycle, Rectangle, 2-Point Arc, 3-Point Arc;

	(0 Deg/90 Deg/180 Deg/270 Deg
	Ориентация объектов под углом (0, 90, 180, 270 градусов)
	Тоже
	Enter/Attribute, Component, Pin;  Draw/Text;

Name/Net, Component

	(Left/Right/Center
	Привязка текста по горизонтали (левая, правая, центральная)
	Тоже
	Enter/Attribute, Pin; Draw/Text;

Name/Net, Component

Query/ Object;

	(MnPul/MnOff/MnBtn
	Обычное выпадающее меню, выключение вертикального меню, подменю размещается на месте основного.
	Тоже
	Все команды

	(Orth/Diag/Any
	Ввод линий и проводников под заданным углом (ортогонально, по диагонали, под произвольным)
	Тоже
	Draw/Line;

Enter/Wire;



	(Path/Group
	Выбор критического пути или группы по имени
	Тоже
	Тоже

	(Имя поля
	Активизация слоя
	Тоже
	Любая команда

	(Mirror
	Нормальное или зеркальное отображение текста
	Тоже
	Enter/Attribute, Component, Pin; Draw/Text; Name/Net, Component Query/ Object;

	(PthGrd
	Выбор критического пути или группы
	Тоже
	Display/Path, Group, Visibility

	( SnpPin
	Захват выводов
	Тоже
	Enter/Wire

	(SwdGrd
	Вкл/выкл координатной сетки
	Тоже
	Любая команда

	(SnpGrd
	
	Тоже
	Любая команда


Примечание: 

(  - Ромбиком помечаются параметры, принимающие несколько значений.
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 (  - Прямоугольником помечаются параметры, принимающие два значения: закрашенный прямоугольник «включено», не закрашенный «выключено».   
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Начальное меню программы 

PCCOMP


Графический интерфейс системы PCAD ориентирован на использование манипулятора мышь и клавиатуры.

Манипулятор мышь выполняет следующие действия:

· Выбор пункта меню или объекта – кратковременное нажатие (щелчок) левой кнопкой (<1>) мыши.

· Отмена выбора или прерывание операции – нажатие правой кнопки (<2>)  мыши.

В системе PCAD используется алфавитно-цифровые клавиши для ввода данных, функциональные клавиши F1-F10 для выполнения определенных команд и клавиши стрелок для перемещения курсора. А также введены «горячие» клавиши  для  типовых  команд.

Проектирование ПП начинается с создания ее принципиальной электрической схемы.  Прежде чем преступить к разработке проекта, следует выполнить следующие операции:

     1.  В разделе Design Manager создать новый каталог для этого проекта и определить имена баз данных принципиальной схемы и баз данных ПП. Для его организации в строке помеченной ромбиком, щелчком мыши включить режим Design Directories. Затем выбрать команду ADD  и на строке Current Design, закрашенной в черный цвет, ввести с клавиатуры имя проекта и нажать [Enter]. Аналогично в режимах Maintain Schematic Sheet и Maintain PCB Layout вводится имена схем и плат.

 2.  Задать имена компонентов, входящих в состав проектируемой схемы и маршруты доступа к ним в Library Manager (пункт Set Libs & Seach Path).

3. Создать отсутствующие в библиотеке символы компонентов в режиме Symbol Editor (раздел Library Manager).

4.  Настроить конфигурацию редактора Editor Configuration раздел Schematic Tools.

[image: image47.wmf] 

Рис. 2.10. Окно для задание конфигурацию редактора Editor Configuration.

Auto Layer Change – автоматическая активизация слоя в котором по умолчанию записывается информация, вводимая по текущей команде.

Rotate Component Text in Four Directions – вращение текста одновременно с вращением компонента.

Load Active Schematic – загрузка при вызове Schematic Editor базы данных, имя которой выделено на основном экране.

Display Verbose Warning – вывод на экран подробных предупреждений.

Auto-Save Configuration – задание временного интервала через который будет появляться запрос о сохранении базы.

Pin Size – размер символа непосредственных выводов контактов в единицах измерения  базы данных  (по умолчанию 10 DBU).

Solder Dot Size – размер соединения проводников в единицах измерения базы данных.

Component Size –  масштаб  графики компонента в процентах от 1 до 10000% (по умолчанию 100%)

Component Text Size – масштаб текста.

3. pccaps

3.1. Технология и этапы создания символьного элемента: 8 этапов.

1. Подготовка.
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Выбрать View Layer  из командной строки просмотра. Установить слои (GATE, PINNUM, PINNAM, PINCON, REFDES, DEVICE) в статус ABL, то есть сделать их доступными. Все остальные установить в OFF (выключить). Слой GATE сделать активным для этого поставить курсор в строке GATE немного правее на пустом месте, щелкнуть мышкой на нем и появится буква А. Установить конструкторскую сетку шагом 10:10. . Командой Zoom In распахнуть окно. Командой Environment/Change UNIT  перейти в метрическую систему. 
2. Рисунок.
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Установить слой GATE. Установить ширину линии W:0. Нарисовать УГО вентиля командами DRAW/ ... . Например, вызвать DRAW/RECT, поставить курсор в заданную точку и щелкнуть первой кнопкой мышки, затем растянуть прямоугольник и щелкнуть второй кнопкой мышки.  Для того, чтобы нарисовать кружок надо уменьшить шаг конструкторской сетки до 5:5. После чего вернуться к 10:10.

3. Текст.
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Установить слой DEVICE. Установить размер текста 20, привязку - по центру, ориентацию - вертикальную. Командой DRAW/TEXT  ввести текст и [Enter].
4 . Ввод контактов
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Контакты вводятся в слой PINCON, а их имена в слой PINNAM. Выбираем команду  ENTER/PIN.  На запрос «Select pin location» выбираем соответствующий контакт (при задании контакта следует контролировать его тип: IN, OUT, I/O и т.д.). На запрос “Select  pin name location”  следует выбрать место, а на «Enter pin name» ввести имя контакта. Командой ENTER/ORIGIN  задается точка привязки (обычно левый нижний контакт символа).

           5. Тип компонента
ENTER/COMPONENT TYPE.

Symbol Old Type=255, New Type = 255 [(]
Выбираем команду ENTER/COMPONENT TYPE. Появляется запрос «Symbol Old Type=255, New Type =». В зависимости от типа символа вводим соответствующий тип.

6. Упаковочная информация
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Упаковочная информация вводится командой ENTER/PACKAGING DATA   и помещается в слои REFDES (позиционное обозначение) и PINNUM (номера контактов). При этом система запрашивает информацию о количестве секций в корпусе и количестве контактов, приходящихся на одну секцию. Затем система предлагает выбрать места для позиционного обозначения и номеров контактов. И, наконец, система потребует ввести упаковочную информацию, т.е. номера контактов для каждой секции.
7. Назначение контактов  
Отредактировать тип и эквивалентность контактов можно командой ENTER/PIN TYPE. Входные контакты кодируются цифрой 0, выходные - цифрой 1. Логически эквивалентными называются контакты, которые можно поменять местами без нарушения функции, выполняемой компонентом. Уникальные контакты кодируются цифрой 0, логически эквивалентные контакты первой группы - цифрой 1, второй - цифрой 2 и т.д.



[image: image14.wmf]ENTER/PIN TYPE

Отредактировать:

— 

тип контактов;

— 

лог

. 

эквивалент.

TYPE  IN1

  : 0 [

¿

]

LEQ    IN1

  : 1 [

¿

]

  .  .  .

TYPE  OUT

 : 1 [

¿

]

LEQ    OUT

 : 0 [

¿

]

1

2

1

2

3

3

4

4

0

0

0

0

0

0

0

0

тип

эквив.


8. Запись в файл.

FILE/SAVE

Enter file name:155LA3 [(]  

Запись символа в файл осуществляется командой  FILE/SAVE. На запрос введите имя файла. Этот файл по умолчанию получит расширение .SYM.

3.2. Создание базы данных принципиальное электрической схемы

База данных принципиальной электрической схемы (т.е. чертёж схемы вместе со служебной информацией о номерах слоёв, именах цепей и т.п.) создаются в режиме Schematic Tools>Schematic Editor (режим Detail Mode). Основные шаги по созданию базы данных принципиальных электрических схем приведены в таблице 3.1.

Таблица 3.1. 

Основные шаги по созданию  баз данных принципиальных электрических схем
	№
	Шаг
	Используемые команды

	1
	Установка среды
	Environment>Change Units, Zoom In, View Layer или File>Load  

	2
	Размещение символов компонентов
	Enter>Component, Copy>Object 

	3
	Ввод электрических связей
	Enter>Wire, слой WIRE 

	4
	Присвоение имён цепям и компонентам
	Name>Net и Net>Component, слои NETNAM и DEVICE

	5
	Построение линий групповых связей 
	Enter>Bus и Draw>Line, слой WIRE и BUS

	6
	Простановка позиционных обозначений компонентов и номеров выводов
	Enter>Ref. Des. & Section

	7
	Атрибуты цепей
	Edit>Net Attr

	8
	Рамка СхЭ
	Draw>Rectangle 

	9
	Запоминание файла
	File>Save

	10
	Подготовка данных к выводу чертежа на принтер/плоттер
	File>Creat Plot File

	11
	Стирание базы данных или завершение работы с редактором
	File>Clear Database или File>Quit  


 Установка среды проектирования 
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Если создание базы данных схемы начинается с загрузки файла форматки листа, то устанавливать среду проектирования не нужно (это делается при создании файлов форматки). Если же это не делается, то сначала с помощью команды View Layer устанавливают статус ABL или ON.   Одному из них присваивается активное состояние ABL A. Остальные слои находятся в состоянии OFF. Затем командой Environment>Change Units устанавливается  система единиц.

1. Размещение символов компонентов
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Компоненты на поле чертежа размещаются по команде Enter>Component. Сначала в ответ на запрос Enter Component name (введите имя компонента) вводиться имя файла символа и масштаб изображения его графики и текста на схеме по формату <имя файла>[.sym] [<масштаб>]. Расширение файла вводить необязательно. Масштаб изображения находиться в пределах от 1 до 10000%; по умолчанию устанавливается равным 100% (масштаб изображения графики и текста можно задать по отдельности при настройке конфигурации схемного редактора).   

 Удобнее вместо ввода на клавиатуре имени файла нажать кнопку PICLIST на строке сообщений и выбрать компонент из списка, как показано на рис. 3.1.

После ввода с клавиатуры имени или выбора его из списка на экране появляется изображение контура компонента белого цвета, и система запрашивает место его расположения: Select loc to place <имя компонента>.sym (Orientation OK?)   

Командная строка при этом приобретает вид, показанный на рис. 3.2.
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На этой строке, не прерывая команды ввода компонента, устанавливается его ориентация (0 Deg, 90 Deg, 180 Deg, 270 Deg), зеркальность изображения (Mirror) и другие параметры. С помощью параметра Angle задаётся угол ориентации, кратный 450. 

 Если символ размещаемого на чертеже компонента создан в другой системе единиц, чем чертёж, выводиться сообщение о преобразовании в другую систему единиц. При подтверждении преобразования символ размещается на поле чертежа; при этом выводы компонента не попадут, как правило, в узлы координатной сетки, что затрудняет присоединение проводников. При ответе NO символ компонента на чертёж не вводиться.

2. Ввод электрических связей
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Ввод электрических связей осуществляется по команде Enter>Wire или Edit>Wire после размещения символов компонентов. После активизации этой команды в строке состояния [image: image52.png]Current Library: [oi\poad_sTjcumnandl.s1b
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устанавливаются параметры (рис. 3.3.):

Рис. 3.3. Параметры ввода проводников

WIRES - слой цепей, устанавливается автоматически; 

Orth - ортогональность линий;

Wid:0 - толщина линий;
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   SnpPin - 
режим захвата вывода компонента при подключении к нему проводника. 

 Курсор подводится к начальной точке цепи, которая фиксируется нажатием кнопки мыши, после чего курсор подводиться к следующей точке, нажимают копку и затем аналогично проводиться следующий отрезок проводника в том же направлении или под углом 900. Для ввода отрезков цепи под углом, кратным 450, или произвольным углом, на строке состояний устанавливается параметр Diag или Any. Ввод цепи заканчивается нажатием второй кнопки или [Esc]. 
3. Присвоение имён цепям и компонентам
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Имена цепей необходимы для соединения как внутри одного листа схемы, так и при создании многолистовых схем, а также для удобства при разводке и контроле ПП. Именем цепи может быть произвольная последовательность латинских букв и цифр. Имя цепи вводиться по команде Name>Net ( при этом должен быть включен слой NETNAM) согласно следующим запросам системы:  

Select a net (выберите цепь) -> Enter net name: (введите имя цепи) -> Name = <имя цепи>. Select location. -> (имя = <имя цепи>. Выберите место расположения имени)  

Курсором выбирают именную цепь (она ярко высвечивается), набирают на клавиатуре её имя и курсором отмечают место расположения имени на схеме. Если нажать на мышке кнопку 2, а не кнопку 1, то имя цепи будет невидимым. 

Заметим, что имя цепи удобно указывать в процессе ввода цепи при выполнение команды Enter>Wire, нажав клавишу F3 (неименованным цепям система присваивает имена по умолчанию, например UN00010181). После этого имя цепи вводиться по подсказке: 

Net name: (имя цепи)   

При этом имя цепи будет невидимым, но его можно "проявить", выбрав эту цепь по команде Name>Net.
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Имена компонентов вводятся по команде Name>Component в слое CMPNAM. Сначала по запросу Select a component (выберите компонент) курсором выбирают компонент, который после этого ярко высвечивается. Далее на запрос системы Enter component name: (выберите имя компонента) с клавиатуры вводят имя компонента, например R1, C7, DD1, DD1., U1, U2. Место расположения этого компонента указывают по запросу   Name = <имя компонента>. Select location (имя=<имя компонента>. выберите место расположения имени)

Имя компонента на чертеже фиксируется нажатием кнопки 1 или [Enter]. Имена компонентов выбираются произвольным образом, однако для удобства их рекомендуется дублировать с позиционными обозначениями компонентов (см. ниже). 

Для удобства, имя компонента можно указать в процессе ввода компонента при выполнение команды Enter>Component, нажав клавишу F4. После этого имя компонента вводиться по подсказке: Component name (имя компонента). При этом имя не будет видимым, его можно "проявить", выбрать этот компонент по команде Name>Component.   

4. Изображение линий групповой связи (шины)
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Шина представляет собой несколько параллельных проводников, воспринимаемых как единое целое. Каждой шине присваивается уникальное имя. 

Для построения шины сначала по команде Enter>Wire изображают проводники от предполагаемого расположения шины до контактов компонентов (устанавливается слой WIRES, ширина лини Wid:0).  После этого по команде Name>Net или Enter>Bus вводят имена проводников (цепей), входящих в шину; соединяемым проводникам присваивают одинаковые имена. Изображение шины наносят на чертёж по команде Draw>Line (слой BUS, ширина линий Wid:12). 

Заметим, что при вводе изображения линий групповой связи удобно использовать команду Enter>Bus, объединяющую в себе команды Enter>Wire и Name>Net для одного или нескольких проводников. По этой команде вначале указывается список имён проводников, образующих шину, после чего на экране вычерчивается изображение первого проводника, указывается место расположения имени проводника и последовательно запрашивается расположение остальных проводников, которые вычерчиваются так же, как первоначальный. Например, проводники, имеющие имена ADR1, ADR2, ADR3, вводятся по следующим запросам:

Enter bus name: ADR<1,2,3> (введите имя шины)  ->  Select start point for path ADR1 (выберите начальную точку для проводника ADR1)  ->  Select next point for path ADR1 (выберите следующую точку для проводника ADR1) ->  Select location for bus bit name: ADR1 (выберите место расположения разряда шины с именем: ADR1)  ->  Select location for ADR2  ->  Select location for ADR3

Список имён проводников, входящих в шину и имеющих общий первый символ имени, может быть указан более компактно, например, список проводников А1,А2,…,А5 вводиться по формату: Enter bus name: имя <начальный номер:конечный номер:шаг>
В рассматриваемом примере по формату А<1:5>. По умолчанию параметр "шаг" принимает значение 1. Кроме того, допускается форматы 

Enter bus name: имя<список номеров>

Enter bus name: список имён
Здесь номера проводников в списке разделяются запятыми, например А<1,2,3,4,5>.

5. Нанесение на схему позиционных обозначений компонентов и номеров их выводов

Компоновка в корпуса компонентов и их отдельных секций производиться при нанесении на схему позиционных обозначений. Позиционные обозначения необходимы программе Package Schematic для составления упакованной базы данных печатной платы.
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Позиционные обозначения компонентов вводятся одним из четырёх способов. 

1 Способ.  Компоновка корпусов и секций производится вручную по команде Enter>Ref. Des. & Section. Курсором по очереди помечают все отдельные секции всех компонентов и по запросам системы

Select a component (выберите компонент) => Enter ref-designator/section (введите позиционное обозначение компонента/ имя секции) 

Вводят их позиционные обозначения (reference designator). Они состоят из позиционного обозначения компонента и имени секции, отдельного от него символом косой черты (секции имеют имена А, В, ….), например DD1/A, DD1/B, DD1/E, DA5/B. По команде Enter>Ref. Des. & Section на чертеже автоматически проставляются номера выводов указанной секции (в слое PINNUM) и наноситься позиционное обозначение компонента без указания имени секции (в слое REFDES). Например, при вводе позиционного обозначения секции DD8/B на изображении секции появляется только надпись DD8 и номера выводов секции. Места расположения номеров выводов и позиционных обозначений выбираются на этапе создания символа компонента. 

Если номер секции желательно сохранить на схеме, то он отделяется от позиционного обозначения компонента не одной, а двумя косыми чертами, например D3//A. 

2 Способ.  Компоновка корпусов производиться вручную, а их секций - автоматически. В этом случае по запросам команды Enter>Ref. Des. & Section курсором по-прежнему по очереди помечают все отдельные секции всех компонентов, но на запрос системы указывают только позиционные обозначения компонентов  без имени секций (при этом номера выводов компонентов на схеме не проявляются).  Например, всем 4 секциям ИС 133ЛА3 присваивают позиционное обозначение DD1. Это позволит программе Package Schematic скомпоновать секции одного корпуса, исходя из удобства прокладки связей на печатной плате. Поэтому после упаковки списка цепей схемы в базу данных ПП необходимо обработать принципиальную схему программой Package Schematic, включив кнопку  Back-Annotate Schematic Sheets в меню Package Schematic. В результате на схеме будут проставлены номера выводов компонентов.  
Кроме того, вместо имени секции можно в круглых скобках перечислить номера всех ей выводов, например, D3(4 5 6). Особенно это удобно при указание номеров выводов компонентов. 

3 Способ.  Компоновка корпусов и вентилей производиться полностью автоматически. Пользователь вообще не присваивает позиционных обозначений компонентам по команде Enter>Ref. Des. & Component.  В дальнейшем это сделает программа Package Schematic, назначая сквозную нумерацию корпусов, например D1, D2,… в том же порядке, в котором вводились компоненты в схему командой Enter>Component (это не удобно и не соответствует ЕСКД, поэтому необходимо использовать специальные программы для преобразования компонентов). Буквенные префиксы позиционных обозначений компонентов назначаются по умолчанию программой Package Schematic или указываются в явном виде в файле перекрёстных ссылок .fil (последнее необходимо, в частности, для аналоговых и цифровых ИС). 
Рекомендуется использовать второй способ, приемлемый с точки зрения соблюдения норм ЕСКД, гарантирующий соответствие ПП принципиальной схеме и достаточно удобный (не требуется указывать имена отдельных секций). 

При этом следует учесть, что контакты разъёмов, которые подключаются к определённым цепям, должны быть предварительно определенны по команде Enter>Ref. Des. & Section.   
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Пример нанесения позиционных обозначений собственно программой приведен на рис. 3.4., что не соответствует нормам ЕСКД. Поэтому перед выпуском документации следует в соответствии с ГОСТ 2.743-82 и ГОСТ 2.759-82 нанести имена компонентов по команде Name>Component. Их рекомендуется задавать в соответствии с существующими позиционными обозначениями. При изображении на схеме компонентов разнесённым образом (рис. 3.5, а) кроме позиционного обозначения по ЕСКД указывается порядковый номер секции, например DD1.1. При изображении компонентов совмещённым способом в качестве имени компонента указывается только его позиционное обозначение (рис. 3.5, б). При необходимости (по требованиям служб нормоконтроля) имена компонентов можно помещать над УГО или справа от него.     
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 Рис. 3.4. Нанесение позиционных обозначений 

             по команде Enter>Ref. Des. & Section

4   Способ.  В Р-CAD 8.7 имеется возможность автоматического присвоения позиционных обозначений и имён секций компонентов при создании схемы, если их символам автоматически присвоить атрибуты PREFIX=<префикс_позиционного_обозначения>. 

При создании символов эти атрибуты по умолчанию располагаются на слое ATTR2. При этом в P-CAD 8.7 предусмотрена возможность автоматического присвоения атрибутов PREFIX всем символам, находящимся в отдельных каталогах или файлах библиотек (.slb) в режиме Assign RefDes Prefix раздела Library Manager. Позиционные обозначения компонентов назначаются автоматически в порядке их размещения их на схеме. Причём непосредственно после размещения символа компонента позиционные обозначения не видимы на схеме - они наносятся на нее после выполнения процедуры упаковки схемы на печатную плату и автоматического выполнения обработки корректировки схемы (режим Package Schematic, раздел Schematic Tools).  

6. Атрибуты цепей

В PC-CAD 8.7 разрешается присваивать цепям различные атрибуты, значения которых передаются в PCB Editor после упаковки схемы на плату. Атрибуты цепей задаются по команде Edit>Net Attr. Цепи выбираются курсором по запросу или указанием имени, выбрав подкоманду ByName. 

Набор стандартных атрибутов цепей для задания технологических ограничений на разработку печатной платы, указан в таблице 3.2. 

7. Рамка СхЭ
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8. Запись на диск базы данных

File/Save

( ...KIS1 [(] } KIS1.SCH

Запись в файл спроектированной схемы осуществляется командой  File/Save. По умолчанию файл получит расширение .SCH.

Таблица 3.3.

	Атрибут цепи
	Назначение

	CLEARANCE
	Допустимый зазор между объектами

	PAD-TO-EDGE
	Допустимый зазор между контактной площадкой и контуром ПП

	PAD-TO-TRACE
	Допустимый зазор между контактной площадкой и проводником

	TRACE-TO-EDGE
	Допустимый зазор между проводником и контуром ПП

	TRACE-TO-TRACE
	Допустимый зазор между проводниками

	VIATYPE
	Тип ПО цепи

	WIDTH
	Ширина проводника на ПП


4. pccaRDs.

 4.1. графический редактор печатных плат и корпусов компонентов

Графический редактор печатных плат и корпусов компонентов (PC-CARDS) используется для решения следующих задач:

· Построения/редактирования графического изображения корпуса отдельного электрорадиоэлемента (создаётся файл с расширением .prt) и стека контактных площадок (КП, создаются в файлах .ps);

· Построения/редактирования контура ПП, на которой осуществляется установка компонентов (создаётся файл с расширением .pcb);

· Построения/редактирования топологии ПП в режиме ручного или полуавтоматического проектирования;

· Размещения компонентов на ПП в автоматическом режиме; кроме того, программа позволяет расставить компоненты вручную и затем в интерактивном режиме или опять же вручную улучшить их начальное размещение (в системе P-CAD 4.5 эти функции выполняла специальная программа PC-PLACE, которая в последующих версиях вошла в состав PCB Editor);

· Создание вспомогательных файлов для вывода чертежей на принтер, плоттер и фотоплоттер.

Графический редактор PC-CARDS работает в двух режимах:

1. PCB Editor (режим DETL) - построение/редактирование базы данных ПП (создаются файлы с расширением .pcb);

2. Part Editor (режим SYMB) - построение/редактирование корпусов отдельных компонентов ПП (по умолчанию создаются файлы с расширением .prt) и стеков контактных площадок (расширение .ps указывается в явном виде).

4.2. Вызов графических редакторов ПП и корпусов компонентов

Редактор печатных плат вызывается с помощью управляющей оболочки в режиме PCB Tools>PCB Editor или двойным щелчком кн.1 мыши на строке с именем файла выбранной платы. Редактор корпусов компонентов - в режиме Library Manager> Part Editor.    
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В детальный режим редактор PC-CARDS переходит после загрузки из пункта основной оболочки PCB Tools>PCB Editor, а в символьный - из пункта Library Manager>Part Editor. Из детального режима можно перейти в символьный по команде File>Level Push при наличии отдельного (извлечённого из библиотеки) файла корпуса компонента в текущей директории проекта. Экран редактора PC-CARDS в режиме SYMB показан на рисунке.
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В английской системе условная единица редактора PC-CARDS составляет 1 мил=0,001 дюйма, т.е. 0,0254 мм, а в метрической системе - 0,01 мм. В таблице 4.1. приведены основные параметры экрана редактора PC-CARDS в обеих системах единиц. 

Таблица 4.4.

	
	Английская система
	Метрическая система

	1 единица базы данных (DBU)
	0,001 дюйма =1 мил = 0,0254 мм
	0,01 мм = 10 мкм

	Шаг сетки,                        min
	0,01 DBU =0.01 мил=0,000254 мм
	0,0001 мм = 0,1 мкм

	                                           max
	2000 DBU = 50.8 мм
	20 мм

	Максимальный размер чертежа
	20 000х20 000"
	200х200 м 


Примечание 

В системе P-CAD 8.7 принята разрешающая способность 0,01 мил в английской системе и 0,1 мкм в метрической системе, чрезмерна для печатных плат. При этом систему единиц нужно выбрать до размещения компонентов на плате и в дальнейшем изменять нельзя. 

4.3. Технология и этапы создания контактных площадок и корпуса элементов: 8 этапов.

Таблица 4.5. 

Основные шаги по созданию корпусов элементов

	№
	Шаг
	Используемые команды

	1
	Установка среды
	Environment>Change Units, Zoom In, View Layer или File>Load  

	2
	Создание посадочного места
	Enter>Pin слой PIN 

	3
	Создание изображения корпуса 
	Draw, слой SLKSCR

	4
	Тестовые обозначения
	Draw>Text, слой DEVICE 

	5
	Выбор точки привязки
	Enter>Origin

	6
	Упаковка 
	Enter>Component Type

	7
	Редактирование типов и кодов эквивалентности выводов 
	Enter>Pin Type 

	8
	Упаковка компонентов: количество вентилей в корпусе и количество выводов в вентиле, присвоение имён и номеров выводов, тип SMD - ответ No 
	Enter>Packaging Data (для неоднородных компонентов используется команда Enter>Nonhomogeneous Pkg)

	9
	Ввод атрибута FP
	Enter>Attribute, слой ATTR

	10
	Запоминание файла
	File>Save

	11
	Подготовка данных к выводу чертежа на принтер/плоттер
	File>Creat Plot File

	12
	Стирание базы данных или завершение работы с редактором
	File>Clear Database или File>Quit


1. Подготовка


[image: image23.wmf]View Layer

Задать

 

логические слои:

PIN

          

 

ABL  

A

SLKSCR

 

 

ABL

DEVICE

   

ABL

ATTR

       ABL

S

ymbol Mode

Z

oom in

Environment>Change Units

Converting...? 

Yes

 No

125:125


По умолчанию в графическом редакторе Part Editor устанавливается английская система единиц. К метрической системе следует перейти по команде Environment>Change Units.   Установить шаг сетки 125:125. Далее курсор помещается в центр экрана и с помощью команды Zoom in устанавливаются необходимые размеры изображения. Затем командой View Layer в состояние ABL установить следующие слои:

· PIN – обозначение выводов;

· SLKSCR – имя слоя контуров компонентов со штыревыми выводами;

· DEVICE – имена компонентов; 

ATTR – атрибуты.

Слой PIN сделать активным ABL A. Все остальные слои должны находиться в состоянии OFF  (невидимы). 

2. Создание посадочного места
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По команде Enter>Pin указываются точки выводов корпуса компонента и каждому выводу ставиться в соответствии геометрия его контактной площадки. Эта информация необходима для связи с файлом специальных символов *.ssf и используется также в файле стратегии *.ctl трассировщика Autorouter.

Перед созданием выводов необходимо, чтобы точка с координатами 0:0 находилась в зоне показа. В этой точке всегда должен располагаться первый вывод компонента. 

После вызова команды  Enter>Pin следует установить параметры строки состояний, как например показано на рис. 4.1. 

[image: image59.png]e

Mumber of Maze Routing Passss

LLL

+ 5 Penalize Comers|
Cost to Rip Up Subnet: [100 unite
20 unite
[T00 unite

Cost to Re-use Rippsd Up Gri

Optimizer Via Cos

. lact Menu |  _Next Menu |  _ Main Menu |




[image: image60.png]Through Via Cost: [20 unite

Masimm Bevel Size: [T sride
Pradominant Componsnt Orisntation: 3 Unspecified
Route Window: s Eaaion |
R TN —
wrx: [0 wryi[0 omile

E
X





После активизации команды Enter>Pin в ответ на подсказку Select pin location: (выберите место расположения вывода) курсор устанавливается в точку расположения вывода и нажимается кн.1 мыши, после чего выбранная для ввода точка помечается на экране курсором синего цвета.    

Предварительно перед выбором места расположения выводов следует в строке состояний курсором выбрать по очереди параметры Type и Equiv и ввести тип и код эквивалентности вывода. Тип контакта кодируется так: первый вывод имеет тип 1, земля - тип 3, питание - тип 4, все остальные выводы имеют тип 2. После выбора места расположения вывода в ответ на подсказку Select pin name location (Attrb OK?) (выберите место расположения имени вывода (атрибуты верны?)) указывается место расположения его имени. При нажатии кн.1 имя будет видимым на экране, а кн.2 или [Esc] - невидимы.  

На этой фазе уместно скорректировать её параметры. После этого в ответ на подсказку Enter pin name [pin number] (введите имя вывода [номер вывода]) вводиться имя вывода (Pin number). Если не указывать номера выводов, то программа по умолчанию присвоит им последовательно номера 1,2,3… Поэтому  выводы следует нумеровать в соответствии с цоколевкой ИС: сначала курсором вывести первый вывод, затем второй и т.д. Имена выводов, указанные по команде Enter>Pin редактора Part Editor, произвольны - другим программам системы  они не используются и никакого отношения к именам вывода символов в SYM - файле отношения не имеют. Поэтому обычно в качестве имени вывода указывается его номер, а номер вывода явно не указывается.  

3. Создание изображения корпуса для СБ
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Контур элемента создается в слое  SLKSCR  командами  Draw/Rectangle  и  Draw/Line  и т.д. Строка состояния при этом имеет следующие параметры: 

SLKSCR - имя слоя контуров компонентов со штыревыми выводами;

Solid - проведение сплошных линий;

Wid:0 - толщина линии.

 Правила выполнения команды Draw такие же, что и для редактора принципиальных схем Schematic Editor. 

4. Текстовые обозначения
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Имя компонента наноситься по команде Draw>Text в слое DEVICE или DVCTOP внутри компонента. В статусной строке подбирается подходящие размер, ориентация и привязка. 

5. Точка привязки 
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В качестве точки привязки обычно выбирается первый контакт микросхемы. Точка привязки вводится командой  Enter>Origin.
6. Упаковка
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Сначала по команде Enter>Component Type вводиться код идентификации типа компонента по запросу Part Old type=10000. New type= (старый тип корпуса компонента =10000. Новый тип =) и тип выводов (планарные или штыревые) по запросу. При создании графического образа корпуса со штыревыми выводами выбирают ответ No.

Компоненты, которые не нужно упаковывать и включать в список соединений, имеют код идентификации 0; компоненты, включаемые в список соединений, но не упаковываемые - код -1.

Затем с помощью команды Enter>Pin Type для контроля желательно проверить правильность ввода типа и кода эквивалентности каждого вывода с возможностью их исправления по запросам:

Enter new type: (введите новый тип)  ->  Type of pin …is … (тип вывода… есть …) -> Enter new code: (введите новый код эквивалентности)  ->  Pin LEQ code is … (код эквивалентности LEQ вывода равен…)

После этого по команде Enter>Packaging Data необходимо ввести количество однотипных вентилей в одном корпусе и количество выводов в одном вентиле по запросам

Enter number of gates: (введите количество вентилей) ->  Enter number of pins per gate: (введите количество выводов в вентиле)

и далее последовательно задать имена выводов и с помощью курсора указать их расположение на чертеже корпуса по запросам

 Enter name of gate pin <n>: (введите имя вывода с номером <n>)  -> Select gate <m> pin <имя вывода> (выберите для вентиля <m> вывод <имя вывода>)

Здесь n=1,2,… - номера выводов (Pin number), введенные ранее, m - номер вентиля. 

Упаковка неоднородных компонентов 

Производиться по команде Enter>Nonhomogeneous Pkg вместо Enter>Packaging Data. Система сначала запрашивает общее количество выводов в корпусе:

Enter the number of gate pins to package: (введите общее количество выводов в корпусе:) 

Затем количество типов неоднородных вентилей:

Enter the number of gate types: (введите количество типов вентилей:)

После этого для вентилей каждого типа по очереди запрашивается упаковочная информация об отдельных вентилях. Сначала запрашивается количество вентилей первого типа:

   Gatetype 1: Enter the number of gates: (вентиль типа 1: введите количество вентилей: )

Далее - количество выводов в каждом вентиле и их имена:

Gatetype 1: Enter the number of pin per gate: (вентиль типа 1: введите количество выводов в вентиле:) -> Gatetype 1: Enter name of gate pin 1: (вентиль типа 1: введите имя вывода номер 1)

Последний запрос повторяется для всех выводов вентиля данного типа. В заключение запрашиваются имена всех вентилей и система просит указать физическое расположение выводов данного вентиля:

Gatetype 1: Enter section 1 name: (вентиль типа 1: введите имя вентиля номер 1)  -> Gatetype 1: Select gate 1 pin <имя вывода> (вентиль типа 1: выберите расположение вывода <имя вывода>)

Расположение вывода с указанным именем указывается курсором. Затем аналогичные запросы выдаются для вентилей остальных типов.  

7. Тип корпуса - групповое имя
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Атрибут FOOTPRINT, используемый при размещении элементов на ПП в автоматическом режиме, вводиться с помощью команды  Enter>Attribute по формату FP=<значение атрибута>
В качестве значения атрибута обычно вводят имя типового корпуса ("болванки"), например DIP16, MLTO_125 и т.п. Атрибут FP сообщает программе PCB Editor о том, какие корпуса одинаковы и их можно менять друг с другом во время перестановок при автоматическом размещении. Атрибуты  FP позволяют программе PCB Editor манипулировать компонентами, имеющими одинаковые геометрические размеры.  

8. Запись в файл

File/Save
( ...7400 [(] } 7400.PRT

Запись в файл спроектированной схемы осуществляется командой  File/Save. По умолчанию файл получит расширение .PRT. Этот файл сохраняется в текущем каталоге проекта, указанном при настройке конфигурации системы.

5. pcB Editor
5.1 . Технология описания конструктива печатной платы. Составление *.fil - файла. Создание файла упакованной базы данных платы (Package Schematic).

Базы данных ПП  создаются во взаимодействии программ PCB Editor, Autorouter и ряда утилит. Графический редактор PCB Editor используется при этом на этапах создания чертежа контура ПП, предварителього размещения элементов, предварительной трассировки соединений (в принципе, можно разработать полностью всю плату в ручном режиме без обращения к программе Autorouter, но это не эффективно).

Перед автоматическим размещением компонентов на ПП необходимо c помощью программы PCB Editor:

· Нарисовать контур ПП в слое BRDOUT;

· Разместить разъемы и другие компоненты, расположение которых будет зафиксировано;

· Присвоить позиционные обозначения этим компонентам;

· Установить элементы крепления;

· Нанести барьеры трассировки.

Эти операции выполняются следующим образом. Создаем файл перекрестных ссылок.  Файл перекрестных ссылок .fil (ФПС).

       Этот файл требуется программе Package Schematic для правильного формирования БДПП из БД электрической схемы. Если позиционные обозначения компонентам присваиваются в схеме, а цепи питания компонентов задаются либо через атрибуты PWGD, либо непосредственным подключением соответствующих цепей к компоненту, и корпуса компонентов указываются через атрибут PRT, то в использовании ФПС нет необходимости.

Файл перекрестных ссылок позволяет задавать соответствие между файлом символа компонета (файлы .sym) и его корпусом (файлы .prt), задавать выводы питания компонентов и присваивать буквенные префиксы для позиционных обозначений в соответствии с кодом SCAT  корпуса компонента.

Любым текстовым редактором создать файл  .FIL, в котором указываются имена всех используемых в данной схеме ЭРЭ. Для каждого ЭРЭ указать его символьное описание (.SYM) и конструкторско-технологическое описание (.PRT). 

Формат файла:
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В необязательном разделе PREFIX указываются префиксы позиционных обозначений компонентов, изменяющие назначения кодов идентификации SCAT:

$PREFIX
[

type1[:type2] = префикс_позиционного_обозначения

]

Параметры type1, type2 задают диапазон типов компонентов, позиционным обозначениям которых присваивается указанный префикс. Эти параметры находятся в пределах –32000…32000. 

Создадим файл упакованной базы данных ПП, выбрав режим Package Schematic в разделе Schematic Tools. На запрос “Output PCB Filename:” указываем имя .pcb файла (my.pcb например). Обычно программа сама предлагает такое же имя как и у файла принципиальной схемы. Выбираем RUN и упаковка выполняется автоматически. 

Запускаем PCB Editor из раздела PCB Tools. Открываем файл: “FILE>LOAD (  ... my.pcb [(]”. Процесс создания конструктива печатной платы показан на рис. 5.1.

[image: image31.wmf]Рис. 5.1. Создание конструктива платы.
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5.2. Ручное и автоматическое размещение элементов. Размещение в сетках. 

В программе PCB Editor имеются группы команд Align, Placement и Improve Plc, предназначенные для размещения компонентов на ПП в автоматическом режиме. Кроме того, имеется несколько средств, помогающих вручную разместить компоненты на ПП. Приведем ниже список команд, используемых в режиме ручного размещения, подготовке и улучшении автоматического размещения:

	Автоматическое размещение
	Ручное размещение

	Placement>Define Lattices>
	Move – Перемещение

	>Enter Spacing – задание узлов решетки
	Swap – Перестановка

	>Define Components – Задание списка компонентов
	Align>Component – Перемещение компонента в узел сетки

	>Associate Discretes – Указание минимального расстояния
	Rotate – Вращение

	>Specify Clearence – Указание мин. Зазора
	Change Layer>Component – Перемещение компонента на другую сторону платы

	Placement>Define Barriers>Enter – Создание барьера
	

	Placement>Enter Cutlines – Задание секущих
	

	Placement>Fix>Component – Фиксация компонента
	

	Placement>Unfix>Component – Отмена фиксация компонента
	


1. Вызов проекта.

FILE>LOAD    

( ... MY [(]  {считать .PKG} 

Подготовка  к автоматическому размещению компонентов на ПП состоит из нескольких этапов.

1. Определение координатной сетки Placement>Define Lattices>Enter Spacing.

Для автоматического размещения компонентов необходимо задать систему сеток. Каждая сетка характеризуется следующими параметрами:

— списком компонентов, размещенных в данной сетке;

— ориентацией компонентов;

— информацией о зазорах между компонентами.

При размещении точка привязки компонента совпадает с одним из узлов сетки.

Команда Placement>Define Lattices>Enter Spacing определяет координатную сетку на выбраном слое, в узлах которой будут размещены компоненты. Сначала вводятся запросы на задание шага сетки и затем координат углов окна, в котором она расположена:
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2. Определение списка компонентов для размещения Placement>Define Lattices>Define Components. 

Команда Placement>Define Lattices>Define Components позволяет выбрать основные компоненты для размещения на конкретной координатной сетке, используя список доступных атрибутов FP, расположеных в правой части экрана в графе Selectable. Для выбора компонента необходимо указать курсором на соответствующий атрибут FP в списке, и программа автоматичски перенесет его в левую чать экрана в графу Defined. Для перехода к следующей координатной сетке необходимо указать ее имя в пунтке Lattice Layers.

3. Определение допустимых зазоров между компонентами Placement>Define Lettices>Specify Clearence. 

Команда Placement>Define Lettices>Specify Clearence позволяет определить минимальные зазоры между корпусами основных компонентов, независимо от координатной сетки.
4. Определение связей компонентов Placement>Define Lattices>Associate Discretes.

С помощью команды Placement>Define Lattices>Associate Discretes Пользователь определяет положение дискретных компонентов относительно основных (ABOVE – выше, BELOW – ниже, LEFT – слева, RIGHT – справа).
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5. Создание барьеров для компонентов Placement>Define Lattices>Define Barriers>Enter.

Команда Placement>Define Lattices>Define Barriers>Enter позволяет создавать на ПП прямоугольные  области – барьеры, внутри которых запрещено размещение компоненотов.

6. Определение секущих Placement>Enter Cutlines.

При автоматическом размещении компонентов в программе используются горизонтальные и вертикальные отрезки (секущие), разделяющие плату на части. Программа автоматического размещения старается разместить компонеты таким образом, чтобы наиболее связанные друг с другом компонеты находились в одной части платы для минимизации связей, пересекающих секущие. При выборе команды Placement>Enter Cutlines автоматически добавляется слой CUTPLC, и он становится редактируемым и активным. На экране в строке состояния появляется параметр, позволяющий изменять направления прокладки сеукщих: HORIZ (горизонтальное) и VERT (вертикальное).Если пользователь не задает секущие, то программа определяет их автоматически. Определенные программой секущие на экране не появляются. 

Расположение секущих указывается курсором по запросу:



Select location. (Выберете место расположения)
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7. Фиксация компонентов Placement>Fix>Component.
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8. Улучшение размещения (парные перестановки).

IMPROVE PLC/COMPONENT  - перестановки компонентов

IMPROVE PLC/GATE - перестановки вентилей

9. Автоматическое размещение компонетов Placement>Automatic Placement.

PLACEMENT/Automatic Placement (  Ready to place (готовы к размещению)?  Yes  [(]
При ручном размещении компонентов можно использовать набор дополнительных функций программы PCB Editor, которые существенно расширяют возможности разработчика. Это  гистограмма заполнения платы и силовые векторы.

10. Гистограммы плотности будущей трассировки.

PLACEMENT/HISTOGRAM/CONFIGURE ... ( PLACEMENT/HISTOGRAM/DEFINE GRID... 

Для появления гистограммы необходимо активизировать поле  ■Hist.
11. Силовые векторы.

Для использования силовых векторов неободимо активизировать поле  ■FcVect в сторке состояния. Силовые векторы выходят из центра каждого компонента. На конце  каждого вектора имеется небольшая окружность, котрая показывает теоретически наилучшее расположение данного компонента. Длина и направление силовых векторов показывает, как далеко расположен данный компонент от своего наилучшего положения и в какую сторону его следует передвигать, если это возможно.

5.3. Создание библиотеки контактных площадок: 7этапов. Файл *.ssf.

Запуск: Library Manager/Part Editor.

1. Установка исходных параметров.
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2. Заполнение графических слоев.
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3. Задание информации для сверления.
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4. Заполнение апертурных слоев в К.П. для ФП.
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5. Запись информации о контактных площадках в файл.

FILE>SAVE  ( 
mask1.ps





mask2.ps





. . .

6. Задание соответствия масок типам контактных площадок.

ENVIROVMENT>EDIT APERTURE TABLE
	%
	TYPE
	STATUS
	PadSrack
	Comment

	
	0
	*
	50R28V.ps
	%Межслойный переход

	
	2
	N
	60R32N.ps
	%Стандартный вывод ИС

	
	5
	C
	60R32C.ps
	%Стандартный вывод ИС

	
	(
	(
	(
	(

	
	тип к.п.

коррект. По

Enter>Pin
	назн. один. Маску, как на занят, так и на своб. конт.
	имена файлов “масок”
	признак комментария


7. Подключение КП (масок) к проекту.

Environment>Edit Aperture Table

Или командой   [/]GSSF[(].
( ... < имя .SSF > [(] 

6. Autorouter. 

6.1. Задание стратегии трассировки: параметры  трассировки  (слои,   алгоритмы,  порядок  трасс,  отображение  на  экране,  45 град.,  мин.  переходов,  ориентация  ЭРЭ,  мин.  изломов,  кол-во  проходов).
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Трассировка выполняется с помощью автотрассировщика, который вызывается из управляющей оболочки системы в режиме PCB Tools. При запуске программы появится меню, показанное ниже.

Ниже приводится описание всех пунктов меню.

Design name – имя текущего проекта.

Input Database Filename – имя файла исходной базы данных ПП.

Output Database Filename – имя выходной (оттрассированной) базы данных.

Strategy Filename – имя файла стратегии трассировки.

Save – сохранение измененной стратегии трассировки в файле стратегии со старым именем.

Save As… - сохранение измененной стратегии трассировки в файле с новым именем.

Route – управление трассировкой с помощью двух параметров. Первый принимает три значения:

♦New – выполнение трассировки первый раз,

♦No – трассировку не выполнять, только извлечь данные из БДПП,

♦Resume – возобновление прерванной трассировки.

Второй параметр  ■Return должен быть включен.

EXIT – выход из основного меню программы Autorouter.

RUN – запуск программы на выполнение трассировки.

ROUTING STRATEGY – раздел редактирования стратегии трассировки. Приведем описание пунктов данного раздела.

1. Routing Parameters (Параметры трассировки).
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На экран выводится меню, определяющее основные характеристики трассировки.

Здесь приведены следующие параметры.

Units – система единиц:

♦Metric – метрическая, мм;

♦English – английская, мил.

ROUTING GRID – координатная сетка. Координаты основной сетки (Major) задаются в полях X, Y. Кроме того, можно задать нерегулярную координатную сетку с помощью вспомогательных (Minor) сеток.

Number of Routing Layers – количество разводимых слоев.

Route Type – тип трассировки: ♦Steiner, ♦Daisy Chain, ♦Minspan, ♦Steiner-Minvia.

Route Order – порядок трассировки: ♦Short-Long – короткие-длинные; ♦Long-Short – длинные-короткие.

Perform Memory Route – трассировка типа «память». Рекомендуется выбирать наиболее эффективный режим ♦Horizontal+Vertical.

■ Diagonal Routing – диагональная трассировка. При трассировке в двух слоях диагональная прокладка трасс не рекомендуется.

■ Via minimization – минимизация количества переходных отверстий.

Perform Beveling – сглаживание углов: ♦No, ♦During, ♦After, ♦During+After.

■ Arc beveling – сглаживание с помощью дуг, при этом углы в 90° на трассах будут заменены дугами.

■ Jog Elimination – ликвидация выступов печатных проводников.

В нижней части экрана приведены три панели:

Last Menu – переход к меню следующего пункта;

Next Menu – переход к меню предыдущего пункта; 

Main Menu – переход к основному меню программы Autorouter.

2. Detailed Parameters (Дополнительные параметры).
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Режим имеет два меню. Сначала активируется первое из них. Ко второму переходят после пункта Detailed Parameters Part2 в нижней части экрана. Меню первой части имеет следующие параметры.

Via Type – тип ПО. Определяет, будет ли программа Autuorouter генерировать сквозные (Through) ПО, межслойные (Interstitial) или ПО обоих типов (Mixed).

Via Sites – размещение ПО (All Grid Points – все точки координатной сетки; Via Lattice – сетка ПО).

Route Search Area Size. Number of Grids to Enlarge – размеры области поиска пути для трассы.

Number of Maze Router Passes. Number of Passes – число основных проходов алгоритма «лабиринт» (0-99).

Open Route Search Area To Full Board On Last Pass – открывать ли всю площадь платы на последнем проходе.

Route Area Clearance From Board Edge Distance – минимальное расстояние трасс от края платы.
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Начальное меню программы 

PCCOMP

На втором экране дополнительного меню задаются следующие параметры:

Through Via Cost – цена сквозного ПО.

Maximum Bevel Size – максимальный размер (в клетках сетки трассировки) 45° трассы, полученной сглаживанием прямоугольного изгиба (0 – размер сглаживания не ограничен и определяется остальными правилами трассировки).

Predominant Component Orientation – преобладающая ориентация компонентов.

Route Window – окно трассировки. 

■ Generate Stringers – генерация «стрингеров». Стрингеры генерируются толко при наличии более двух слоев трассировки. Рекомендуется оставлять значение по умолчанию – включение генерации стингеров.

■ Eliminate Acute Angles – удаление острых углов. Рекомендуется оставлять значение по умолчанию – включение этого режима.

3. Rip-Up Parameters (Параметры алгоритма Rip-Up).

[image: image66.wmf] 

Этот раздел позволяет управлять наиболее мощным средством программы, так называемым Rip-N-Route (Rip-Up) алгоритмом (стираю и прокладываю). Использование этого алгоритма особенно необходимо, если после выполнения обычных основных проходов трассировки на ПП остались неразведенные связи. В меню пункта Rip-Up Parameters (рис. Ниже) изменяют следующие параметры. 

Number of Maze Router Passes – количество проходов каждого из указанных ниже алгоритмов трассировки. Все они являются разновидностями алгоритма «лабиринт», приспособленного для решения определенных задач:

Normal – эквивалентен  параметру Number of Maze Router Passes из раздела Detailed Routing Paremeters Part 1.

Rip-Up – указывает  программе количество попыток развести каждую из неразведенных связей алгоритмом Rip-up. Рекомендуется использовать один проход, независимо от числа проходов трассировщика «лабиринт».

Optimize – количество попыток переразвести каждую связь с целью уменьшения числа ПО, при этом программа также будет пытаться развести ранее не разведенные связи, даже если количество ПО при этом увеличится.

■ Trace Hugging – уплотнение трасс.

■ Penalize Corners – уменьшение количества изгибов проводников. Это требование вступает в противоречие с параметром «уплотнение трасс», у которого более высокий приоретет.


Далее указываются весовые  коэффициенты, с помощью которых настраиваются алгоритмы Rip-Up и Optimizer:

Cost to Rip Up Subnet – вес стирания одной связи (в интервале 0…999). Рекомендуемое значение этого параметра в десять раз больше, чем за переходное отверстие.

Cost to Re-use Ripped Up Grid – цена за повторное использование сетки. Рекомендуемое значение – 1/5 от значения цены за стирание одной цепи.

 Optimizer Via Cost – цена за ПО при оптимизации (0…999). Рекомендуемое значение этого параметра в десять раз больше, чем за ПО.

Рекомендованные значения весов осят субъективный характер и зависит от конкретной ПП.

4. Pad Description (Определение контактых площадок).

Этот раздел позволяет указывать программе Autorouter форму и размер контактых площадок для всех типов отверстий (под выводы компонентов и переходные и переходные отверстия). Меню редактирования определений контактных площадок изображено ниже. 

В начале меню приведена таблица существующих контактных площадок (КП).

Таблица состоит из следующих граф:

Pin Type – номер типа вывода;

Connected to Inner Plane – наличие у выводов проводимости во внутреннем плане (Yes/No);

Shape – соответствующая данному типу форма КП;

Size – геометрические размеры КП.

Добавление новой КП выполняется по команде Add, удаление – Delete. Для редактирования КП ее описание помечается курсором, новые значения параметров вводятся в соответствующих панелях.

5. Wiring Rule Definition (Определение правил прокладки проводников).

Правила прокладки проводников используются для определения ширины проводников и величин зазоров. Для каждого значения ширины должно быть определено особое правило прокладки.

Меню раздела содержит список определенных правил прокладки, которые могут изменяться или удаляться пользователем.

Программа Autorouter не позволяет удалять те правила прокладки, на которые ссылаются классы цепей.

Вверху задается зазор Pad/Pad Clearance – контактная площадка-контактная площадка.

Каждое правило прокладки содержит следующие параметры:

Rule Name – имя правила. Каждое правило должно иметь имя. По нему будет осуществлятся ссылка из классов цепей. Рекомендуется присваивать имя DEFAULT правилу, определяющему значение наиболее часто встречающейся ширины проводника.

Trace Width – значение ширины проводника.

Trace/Trace Clearance – величина зазора типа “проводник-проводник”.

Trace/Pad Clearance – величина зазора типа “проводник-контактная площадка”.

Трассировка начинается после активации возможности Route: ♦New и выбора команды RUN
в основном меню прогаммы Autorouter. Файл отчета работы трассировщика имеет расширение .rep.

7. PCCOMP. Обслуживание библиотечных элементов.  PCLIB. Обслуживание библиотек (*.slb, *.plb). 

Программа PCCOMP отображает информацию о выводах и упаковке символа (*.SYM) и корпусов (*.PRT) компонентов в табличной форме, что упрощает процесс её редактирования. Представление информации в табличной форме позволяет изменить содержание соответствующих данных, не вызывая для этого графические редакторы Symbol Editor или Part Editor . Программа PCCOMP имеет такие же возможности, что и команды Edit графических редакторов. При этом пользователь может изменить только текстовую, но не графическую информацию, т.е. нельзя добавлять, уничтожать или изменять положение выводов компонентов. Однако программу PCCOMP можно использовать для создания новых компонентов, комбинируя графическое изображение одного уже существующего компонента и упаковочную информацию другого. Она также позволяет упаковывать неоднородные компоненты. Вызов программы в интерактивном режиме производиться в пункте Component Editor режима Library Manager. После выбора режимов Open Symbol или Open Part выводиться запрос имени редактируемого компонента. Её начальное меню показано на  рис. 7.1.


1. Open Symbol 

Сначала на экран выводиться таблица, содержащая  имена выводов (Pin Name), типы выводов (Pin Type) и их логическую эквивалентность (Pin LEQ), а также недоступные для редактирования графы координат выводов Pin x, Pin y. 

Кроме того, в этом режиме доступны следующие подрежимы:

· Edit Symbol Packaging - редактирование упаковочной информации символа - редактирование информации об упаковке символа (т.е. номеров выводов во всех секциях компонента). Каждая строка выведенной на экран таблицы отведена имени одного вывода (Section Pin Name); в столбцах указаны номера выводов (Part Pins) с одинаковыми именами, принадлежащих секциям А, В, С, … (Section Name).
· Component Property - свойства компонента - редактирование типа компонента (Component Type), номеров и имён выводов питания (Power Pins) и кода идентификации типа корпуса компонента (Packaging ID).  
· Copy Packaging to Clipboard - копирование упаковочной информации из буфера - копирование в текущий символ информации об упаковке из буфера обмена. 
· Delete Packaging - уничтожение упаковочной информации - удаление информации об упаковке текущего символа.  
· Generate Report - создание текстового файла описания упаковочной информации о символе (.rpt).
2. Open Part 

Сначала на экран выводиться таблица, в которой содержится та же информация, что и в режиме Open Symbol. В нижней части таблицы выводов компонентов упорядочены по их номерам. В каждой строке указан номер вывода, имя вывода, тип вывода, логическая эквивалентность вывода, координаты вывода, имя вывода секции (Sect. Pin Name) и имя секции (Sect. Name). Возможно редактирование только первых четырёх столбцов таблицы. 

Этот режим используется, в частности, для редактирования номеров выводов компонентов, имеющих несквозную нумерацию выводов. 

· Кроме того, в этом режиме доступны следующие подрежимы:

· Delete Packaging - удаление информации об упаковке текущего символа.

· Component Property - редактирование типа компонента (Component Type), имени атрибута FP (Footprint Value) и признака принадлежности компонента к компонентам с планарными выводами (Component is SMD/not SMD).

· Copy Packaging to Clipboard - копирование в буфер обмена информации об упаковке текущего корпуса.

· Past Packaging from Clipboard - передача текущему корпусу информации об упаковке, находящейся в буфере обмена.

3. Translate Packaging 

Имена исходного и выходного файлов указываются по запросам программы:

· Destination Part Name - имя файла корпуса, в который нужно передать упаковочную информацию;

· Number of Inputs Symbols - количество файлов символов, которые нужно упаковать в один корпус;

· Source Symbol Name - имена файлов символов, упаковываемых в один корпус (имена файлов добавляются по опции ADD).

Этот режим удобен для формирования неоднородных компонентов. Сначала с помощью графических редакторов Part Editor и Symbol Editor создают корпус неоднородного компонента в файле .prt и символы отдельных секций в файлах .sym (всем им присваивается одинаковый идентификатор упаковки Packaging ID , совпадающий с именем корпуса), а затем программа PCCOMP корректно создаёт информацию об упаковке в файл  .prt .  

Программа  PCLIB предназначена для создания и обслуживания библиотек ЭРЭ. Библиотеки представляют собой сжатую информацию по сравнению с набором SYM- или PRT-файлов. 

Перед загрузкой программы Library Maintenance (PCLIB) необходимо выбрать в оболочки системы имя проекта, в котором будете работать с библиотеками. Затем в пункте Set Libs & Search Paths укажите имена одного или нескольких библиотечных файлов, с которыми предполагается работать. Программа Library Maintenance запускается из оболочки системы в пункте Library Maintenance в режиме Library Manager, после чего выводиться её начальное меню, в котором команды программы Library Maintenance разбиты в меню на три группы.

1 Команды группы File выполняют операции:

· Clear Database - очистка текущей базы данных;

· Load (File/Load) - загрузка новой библиотеки для дальнейшей с ней работы;

· Save (File/Save) - сохранение библиотеки;

· Exit - завершение работы с программой;

· Dos Shell - выход в оболочку DOS;

2 Команды группы Edit создают/редактируют библиотеку:

· Add (Edit/Add) - добавление компонента в библиотеку; здесь кроме имени файла символа указывается имя слоя (но это необязательно) в котором будет размещёно имя компонента;

· Delete - удаление компонента из библиотеки;

· Extract - извлечение компонента из библиотеки в отдельный файл;

· Replace - замена конкретного компонента библиотеки данными из другого файла с другим описанием этого компонента. Имя файла замещающего компонента должно совпадать с именем заменяемого компонента. При необходимости указывается имя слоя для размещения функционального имени компонента.

· Alias - присвоение дополнительного имени (псевдонима) компоненту. Псевдоним  - не обязательный параметр, он представлен парой имён, помещённых в графах Alias Name  (имя файла подобного компонента) и Devise Name (имя псевдонима). Например: 133LA3.prt 1533 LA3  

133LA7.prt 531La7 1533La7

3 Третья группа состоит из единственной команды List - вывод списка компонентов, помещённых в библиотеку.

Список команд программы Library Maintenance:

· Add - добавить элемент в библиотеку;
· Alias - ввести дополнительное имя (алиас) для элемента библиотеки;
· Delete - стереть элемент из библиотеки;
· Dos - выполнить команду MS-DOS
· Extract - извлечь элемент из библиотеки;
· Help - помощь;
· List - вывести на экран или в файл список элементов библиотеки;
· Load - загрузить библиотеку;
· Quit - завершить работу;
· Replace - заменить элемент в библиотеке на новый;
· Save - сохранить библиотеку на диске;
· Statistic - вывести на экран информацию о библиотеке;
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Рис. 3.5. Нанесение имён компонентов по ЕСКД при разнесённом (а) и совмещённом (б) расположении





Рис. 3.2. Выбор ориентации, зеркальности и других параметров





Рис. 3.1. Выбор символа компонента из списка
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Рис. 4.1. Содержание строки состояния при выполнении команды Enter>Pin редактора Part Editor
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Рис. 2.2. Структурная схема системы PCAD 8.7.
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Рис. 2.6. Функциональные схема и связи.
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Рис. 5.1. Создание конструктива платы.
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Рис. 2.7. Функциональная схема и связи.
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Рис. 2.4. Основные логические слои PC-CAPS.
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Рис. 2.5. Основные логические слои PC-CARDS.
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Рис. 2.3. Режимы работы модулей PCAD 8.7.







Рис.13. Режимы работы модулей PCAD.
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Рис. 2.1. Общая структура PCAD 8.7.
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          1      cap        ck06.prt                                  caph.sym



          4      c4011b  c4011d.prt  (7=gnd,14=+5V)  c4011b.sym



          6      5404b    5404b.prt   (7=gnd,14=+5V)  5404b.sym











Список выводов подключения источников питания и «земли» по формату 



(<номер вывода>=<имя цепи>,<номер вывода>=<имя цепи> …).












_1009017958.doc


<1>







Select component:







PLACEMENT>UnFix - раcфиксировать ЭРЭ







PLACEMENT>Fix>Window - фиксировать группу (в окне)







PLACEMENT>Fix>Component - для фиксации отдельных ЭРЭ
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Component name?  <имя позиц. обозн. ЭРЭ>











By Name
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CPMNAM  ABL
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Задать логические слои:







View Layer
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Environment>Change Units 



Converting...? Yes No
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Symbol Mode







Zoom in
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Draw/Rectangle 
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Enter/Wire
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<1> или <2>







DD2/A







( ...<имя> [(]
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Name/Component
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CPMNAM
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или



Enter/Bus



... 1, 2, 3 [(]



<создать образец>







<поместить образец в ост. т. шины>
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Name/Net







Enter/Wire
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<2> - невидим.



<1> - видим.







место







+  A1







( ... <имя> [(]







цепь







выдел. цепи (ярко)
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Name/Net
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<1> 







Zoom In <1> - выбрать необходимый масштаб изображения
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Enter X  position:  0 [(]







XY: 100:235 <1>







размер сетки для рисования







5 : 5







PADCOM ABL  A



PADSLD  ABL



PIN           ABL



DRILL	    ABL







View Layer







Задать логические слои:







Enter Y  position:  0 [(]
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ENTER>ORIGIN












_1008877243.doc


<1><2>







<1>







&







&







курсор
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(повторить для других № масок К.П.)







  . . .  :  (0;0) <1>  (             - слой  FLSOLD







Сменить слой:







<1> 







FLSOLD







  . . .  :  (0;0) <1>  (             - усл. отображение (60DBU







Enter aperture number: <число 1...32, опред. № маски ФП> [(]







Select location:







APER:1







DRAW>FLASH







FLCOMP ABL  A



FLSOLD  ABL







View Layer












_1008870987.doc
[image: image1.bmp]

ширина линии для рис. К.П.







К.П. в слой  PADSLD







Center point:  (0,0)







Point of circ ...:  (15,0)







сменить слой







PADSLD







К.П. в слой  PADCOM
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Specify Clearance
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PLACEMENT/DEFINE LETTICES/
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TYPE  IN1  : 0 [(]



LEQ    IN1  : 1 [(]



  .  .  .



TYPE  OUT : 1 [(]



LEQ    OUT : 0 [(]























ENTER/PIN TYPE







Отредактировать:



— тип контактов;



— лог. эквивалент.
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